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Аннотация
Методическая разработка «Методы преобразования цветного изображения в чёрно-белое» может быть использована преподавателями фотокружков при проведении занятий по теме «Корректировка и улучшение цифровых фотографий», «Графические редакторы».


Введение

Даже поверхностный просмотр любого модного журнала, социальной сети, специализированного фотосайта подтверждает, что черно-белые фотографии сегодня популярны, как никогда. Даже с приходом цифры ничего не изменилось.
[image: фотошоп черно-белое]В плёночной фотографии чёрно-белое преобразование происходит практически во время съёмки. Если Вы хотите изменить характер чёрно-белого преобразования, Вы можете сделать это только путём размещения цветного фильтра на объективе (так, например, красный светофильтр значительно затемняет голубое небо). Хотя, в относительно небольших пределах можно регулировать преобразование подбором проявителя, длительностью проявки, подбором бумаги и маскированием при печати.
В цифровой же фотографии с его мощнейшим оружием — Photoshop’ом — мы имеем полный контроль над преобразованием. Затемнить, например, голубое небо легко, надо только решить, каким оно должно стать, и выбрать наиболее подходящий инструмент.
Большинство цифровых аппаратов имеют встроенный режим преобразования изображения в чёрно-белое. Однако это преобразование, во-первых, необратимо, во-вторых, нерегулируемо, а главное — даёт плоское, невыразительное, малоконтрастное изображение. Чтобы избежать подобного разочарования, мы и обсудим разные варианты преобразования цветных изображений в чёрно-белые без использования фотоаппарата.

 

Преобразование в чёрно-белое цифрового цветного фото

Photoshop предлагает как разрушающие, так и неразрушающие методы чёрно-белого преобразования. Разрушающими являются те, которые не могут быть повторно отрегулированы. После сделанных преобразований, единственный способ изменить их — отменить всё и начать заново.
Неразрушающие же методы используют слои. Изменения, которые Вы вносите в изображение, хранятся в (корректирующем) слое, а оригинал остаётся неизменным. Затем, когда Вы закончите, Вы можете либо сохранить изображение в формате PSD, либо TIFF с целью дальнейшего открытия и редактирования, либо свести слои воедино, и сохранить изображение в формате .JPEG (с потерями).
Когда цветное изображение преобразуется в монохромное, мы теряем две из трех составляющих контрастности, которая, собственно, и позволяет различить изображенные на снимке предметы.
[image: ]В градациях серого нет места различиям цветовых тонов. Это означает, что вместо синего и красного, столь хорошо разделяемых визуально, получаются две градации серого. Причем, в зависимости от метода конвертации, они могут оказаться настолько близки, что собственно различий вы даже не заметите.
К левой половине изображения применен метод обесцвечивания путем создания корректирующего слоя Hue/Satureation. Представьте, что ваш снимок, полный ярких цветов, превращается в невнятную серую кашу…
Каждая фотография индивидуальна. К каждой необходим свой уникальный подход, метод. Если рассмотреть результаты преобразования различными способами, предлагаемыми программой Photoshop, нетрудно заметить разницу и выбрать лучший.

Методы преобразования цветного изображения в чёрно-белое

1. Преобразование в градации серого (разрушающий).
Самый простой способ преобразования. Отменяет всю информацию о цвете в объекте.
Изображение — Режим — Градации серого.
[image: ]
Плюсы: быстро и просто.
Минусы: Абсолютное отсутствие контроля над преобразованием.

2. Использование Цветового тона/Насыщенности
Данный метод снижает насыщенность всех цветов, приводя разные цвета одинаковой яркости к одному серому тону.
Изображение — Коррекция — Цветовой тон/Насыщенность (Ctrl+U) (разрушающий).
Слои — Новый корректирующий слой — Цветовой тон/Насыщенность (неразрушающий).
Перемещаем ползунок Насыщенность до упора влево (-100).
[image: ]

Плюсы: Быстро и легко. Может быть использован как корректирующий слой (со всеми вытекающими).
Минусы: Отсутствие контроля.

3. Метод LAB-color (разрушающий)
Использование канала яркости в режиме LAB является быстрым и простым способом, поскольку преобразование происходит на базе значений яркости из комбинации RGB в каждом пикселе.
Прежде всего преобразуйте изображение в пространство цвета LAB, используя меню «Image → Mode → Lab Color» программы Photoshop.
[image: Канал яркости в режиме LAB]Включите просмотр канала яркости, нажав на «Lightness» (как показано слева) в окне каналов. Если окно каналов ещё не открыто, откройте его из меню «Window → Channels».
Удалите каналы «a» и «b» (они соответствуют красно-зелёному и сине-жёлтым смещениям или «хроматическим данным»), чтобы остался только канал яркости.
Учтите, что канал яркости может потребовать значительной коррекции уровней, поскольку он может не полностью использовать тональный диапазон гистограммы. Это происходит потому, что для достижения максимума нужны предельные значения во всех трёх каналах, тогда как в гистограмме RGB хватило бы одного из трёх.
[image: ]
Плюсы: Даёт лучший результат, чем предыдущие преобразования.
Минусы: Разрушающий метод, который не даст Вам возможность контроля.

4. Обесцвечивание
Простейшим преобразованием является обесцвечивание изображения, однако оно зачастую даёт неадекватные результаты. Происходит это потому, что такой способ не позволяет управлять процессом смешивания первичных цветов при вычислении градации серого. Несмотря на это, такой метод, вероятно, является наиболее часто используемым при преобразовании изображения в чёрно-белое. 
[image: ]
В Фотошопе обесцвечивание производится из меню «Image → Adjustments → Desaturate».

5. Карта градиента
Почему инструмент Карта градиента называется именно так? Потому что он представляет собой именно карту, карту соответствия того, что было, тому, что будет в новом изображении. 
Например, в нашем случае необходимо, чтобы самые темные участки стали чёрными, а самые светлые — белыми, а всё остальное, между ними — оттенками серого. Поэтому в качестве карты для перевода изображения в чёрно-белое мы и выбираем чёрно-белый градиент (плавный переход). 
Если бы нам было необходимо, мы могли бы выбрать другие цвета. Пусть, например, самые тёмные участки превратятся в красный, а самые светлые — в жёлтый. В итоге мы получим красно-жёлтое изображение с оранжевыми полутонами.
Разумеется, можно выбрать не два цвета, а больше, и отрегулировать ширину переходов между ними.
Мы можем использовать метод как в разрушающем, так и в неразрушающем варианте.
Первым делом для любого варианта нажимаем клавишу D, чтобы установить цвета основы и фона — по умолчанию — чёрным и белым.
[image: ]
Далее — используем одно из двух:
Изображение -Коррекция — Карта градиента (разрушающий);
Слои — Новый корректирующий слой — Карта градиента (неразрушающий).

6. Микширование каналов
Микшер каналов — первый из перечисленных здесь инструментов преобразования в чёрно-белое, который использует весь потенциал информации, содержащийся в цветной фотографии. В пространстве RGB цвет фотографии образуется из трёх каналов — красного, зелёного и синего. Из этих основных цветов состоит любой из миллионов оттенков на фотографиях.
Преобразование, использующее Микширование каналов, позволяет регулировать соотношения между красным, зелёным и синим каналами. Уменьшение значения в канале осветляет цвета, близкие к нему на цветовом круге и затемняет цвета, расположенные напротив него. Например, увеличьте значение красного канала, и красные тона на Вашем фото станут светлее, зато потемнеют голубые. Осветлите тона кожи, и потемнеет голубое небо.
У нас опять же есть выбор между разрушающим и неразрушающим методом:

Изображение — Коррекция — Микширование каналов (разрушающий)
Слои — Новый корректирующий слой — Микширование каналов (неразрушающий);
Отметьте Монохромный.

До того как корректировать процентный вклад исходных каналов, посмотрите, как каждый из исходных каналов влияет на монохромное изображение. Например, в режиме RGB проверьте, как будет выглядеть изображение, если для красного канала выбрать значение +100%, а для зеленого и синего исходных каналов — значение 0%. После этого просмотрите изображение с исходным зеленым каналом на уровне +100% и остальными двумя на уровне 0%. Наконец, просмотрите изображение с исходным синим каналом на уровне +100 % и остальными двумя на уровне 0 %.

Старайтесь, чтобы в сумме все три ползунка давали 100% (поле Всего), иначе рядом с ним появляется предупреждающий значок, указывающий на то, что обработанное изображение будет ярче оригинала и некоторые освещённые детали будут засвечены.
[image: ]
Плюсы: Дает высокую степень контроля черно-белого преобразования.
Минусы: Средний уровень.

7. Двухслойный Цветовой тон/Насыщенность (неразрушающий)
Эта техника использует два корректирующих слоя Цветовой тон/Насыщенность. Верхний слой представляет собой прямое монохромное преобразование. Нижний — меняет цвет исходного изображения. А вместе они дают очень высокий уровень контроля. 
Итак, дважды добавляем корректирующий слой Цветовой тон/Насыщенность. В верхнем слое перемещаем ползунок Насыщенность влево до упора (-100), а у нижнего меняем режим наложения на Цветность. Перемещайте ползунок Цветовой тон в нижнем слое вправо и влево и удивляйтесь!
[image: ]

Плюсы: Возможность очень тонкого контроля над процессом преобразования.
Минусы: Неидеален.

8. Корректирующий слой Чёрно/белое
Принцип работы команды состоит в осветлении тех или иных цветов при переводе в оттенки серого.
Как и некоторые другие, этот инструмент существует в двух ипостасях — разрушающей и неразрушающей:
Изображение — Коррекция — Чёрно-белое (разрушающий);
Слои — новый корректирующий слой — Чёрно-белое (неразрушающий).
Как и некоторые другие — имеет в своём арсенале как предустановленные наборы смешения серого, так и созданные и сохранённые варианты смешения. Кнопка Авто максимизирует распределение значений серого. Автоматическое смешение зачастую позволяет добиться отличных результатов, но также его можно использовать в качестве начальной точки для настройки значений серого при помощи цветовых ползунков. 
[image: ]
Если в изображении содержатся контрастные оттенки, разделить их по яркости тонов относительно легко, для этого достаточно развести движки противоположных цветов в разные стороны. Труднее будет с близкими цветами. Однако в некоторых случаях, например, в пейзажных сюжетах, необходимо растащить в разные стороны движки зелёного и жёлтого цветов, поскольку в природной зелени достаточного много жёлтого цвета.
Плюсы: самый гибкий метод чёрно-белого преобразования.
Минусы: Присутствует только в Photoshop начиная с версии CS 3.

9. Вычисление
Перегруженное, на первый взгляд, диалоговое окно Calculations предназначено для простого комбинирования каналов изображения. Команда Calculations позволяет объединять одно или несколько изображений одинакового размера с использованием 20 основных режимов наложения, а также двух дополнительных — Add и Subtract. Команда Calculations дублирует процесс перетаскивания одного изображения на другое (или копирования изображения на новый слой), а также использование разных режимов наложения и параметра Opacity (Непрозрачность) палитры Layers для наложения двух изображений. Команда Calculations работает только с отдельными каналами: один из каналов изображения накладывается на канал другого (или того же самого) изображения, а результат помещается в новый канал или новый документ.
· Копия слоя
· Изображение - Вычисление
· Источник 1 – зеленый
· Источник 2 – красный
· Наложение – замена темным
· Непрозрачность – 80%
[image: ]
Повторим: 
· Источник 1 – зеленый, 
· Источник 2 – зеленый, 
· Наложение – замена темным, Непрозрачность – 60%
Переведем альфа-каналы в режим серого, затем в режим RGB
[image: ]




Заключение

Наверное, стоит найти время, чтобы познакомиться с этими методами для принятия решения о способе преобразования в каждом конкретном случае. Все они имеют право на жизнь и применение, каждый в своё время. Зачастую перевод изображения в ч/б служит просто промежуточным этапом некоторой последовательности команд. Какое из преобразований Вы выберите для конкретной обработки — зависит от вашего вкуса и пристрастий. Только помните о сохранении оригинала, если используете разрушающие способы обработки.
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